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Building a Mass Model 
In this exercise you begin in a Massing model that is 
already begun. To it we will add additional forms to 
complete a basic building model form.  

 
You do the following: 
• Create solid mass forms 
• Create voids and combine solids 

 

Exercise 1 – Create a new Solid Form 
1. Open the file named:  

01_Mass Model_Start_V2.rfa 
 

• Open the {3D} view. 
• On the ViewCube, click the Home icon 

 

2. Zoom out a little and click on the Level to 
make it the active work plane.  

3. On either the Create or Modify tab, on the 
Draw panel click the Rectangle icon.  

 

 

4. Snap to each of the points located on the 
ground plane.  

 

 

5. Click the Modify tool or press ESC to finish. 
6. Move the mouse near the rectangle just 

created. It will highlight the entire shape 
(chain). Click to select the chain.  

7. On the ribbon, click the Create Form 
button.  

 

 

8. Click away from the form to deselect it. 

Exercise 2 – Join Forms 
Continue in the previous file. 
 
1. On the Modify tab, on the Geometry 

panel, click the Join button.  
2. Click the box just created. 
3. Click the smaller box to the West.  

The two forms will join with a resolved edge between 
them.  

4. Repeat for the for to the East. 
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Exercise 3 – Create a Solid and Void 
Continue in the previous file. 
 
1. Zoom in on the shapes on the East side of 

the building. 
2. Select the L shape on the left.  
3. Click the Create Form button.  

 

4. Highlight the green arrow on the form 
and drag it to the right across the top of 
the roof.   

5. Change the temporary dimension value to 75. 

 

6. Click directly on the vertical surface on 
the East side of the new roof form.  

This will set this as the active work plane.  

7. Draw a rectangle directly on this surface. 
Make it approximately 18 x 28. 

8. Cancel the command, select this rectangle 
and then click the drop-down portion of 
the Create Form button and choose Void 
Form.  

 

9. Click away from the element to deselect it 
and see the result.  

 

Exercise 4 – Create a “Lofted” Form 
Continue in the previous file. 
 
1. Zoom in on the shapes on the North-West 

side of the building. 
 

• The lines on the ground will be the 
path. 

• The wedge shape will sweep along the 
path. 
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2. Select the wedge shape and then using 
the CTRL key; click the path on the ground 
to select it as well.  

3. Click the Create Form button.  

 

 

Exercise 5 – Save and Load Into Project 
1. Close all files.  
2. On the QAT, click the Open icon. 
 

• Browse to file named: 05_Schematic 
Project_Start.rvt. 

• Select it and then click Open. 
 

3. On the QAT, click open again. 
• Select the 05_Mass Model_V2.rfa file 

and open it. 
 

4. On the ribbon, click the Load Into Project 
button.  

   

5. In the dialog that appears, simply click 
close.  

This will enable the display of masses in the project.  

6. On the Modify | Place Mass tab, ensure 
that Place on Work Plane is active and 
then click a point in the middle of the 
screen to place the model.  

7. Click the Modify tool or press ESC to 
cancel.  

8. On the QAT, click the Default 3D View 
icon.  

 

9. Save the file with a new name.  
 

Exercise 6 – Creating Mass Floors 
Continue in the previous file. If you closed the file, you can 
open 06_Schematic Project_V1.rvt and make sure that on 
the Massing & Site tab, that Show Massing by View is 
toggled on. Make sure you are in a 3D view and zoom to fit.   
 
1. Select the massing model onscreen.  
2. On the Modify | Mass tab, click the Mass 

Floors button.  

 

3. In the “Mass Floors” dialog, check GROUND 
FLOOR, LOWER LEVEL, SECOND FLOOR and 
TOWER.  

4. Click OK.  
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It can be a little easier to see what we have done if we 
shade the model.  

 

5. On the View Control Bar, click the Visual 
Style pop-up and choose Shaded.  

 

Exercise 7 – Analyzing Mass Floor Area 
Continue in the previous file. If you closed the file, you can 
open 07_Schematic Project_V2.rvt and make sure that on 
the Massing & Site tab, that Show Massing by View is 
toggled on.  
 
1. Select one of the Mass Floors (use the TAB 

key if necessary). 
2. Take note of the area and other values on 

the Properties palette.  

 

3. On the View tab, click the Schedules drop-
down and choose Schedules/Quantities.  

4. In the “New Schedule” dialog, from the 
Category list, choose Mass Floor.  

 

5. In the “Schedule Properties” dialog, on the 
Fields tab, choose Level, then Floor Area 
and then Floor Perimeter.  

6. Click OK to display the schedule.  

 

 

Exercise 8 – Adjusting Schedule Formatting 
Continue in the previous file.  

Let’s adjust some formatting and add a total at the 
bottom. 
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1. Click in the header above the Floor Area 
column (labeled “B”). 

 

2. On the Modify | Schedule/Quantities tab, 
on the Appearance panel, click the Align 
Horizontal drop-down and choose Right.  

 

3. Repeat for column “C” (the Floor Perimeter 
column).  

4. Click in the Level header and drag across 
the other two headers. (Do this in a single 
motion, click and drag across the columns 
together). 

This will highlight all three headers 

 

5. On the ribbon, click the Font button and 
choose Arial Black. Click OK.  

6. Click the Align Horizontal drop-down again 
and choose Center.  

7. On the Properties palette, click the Edit 
button next to Sorting/Grouping.  

8. Check the Grand Totals box.  

9. Click the Formatting tab, select Floor Area 
and then check the Calculate Totals box.  

 

10. Click OK.  

 

Exercise 9 – Update the model 
Continue in the previous file.  

Changes to the model are immediately reflected in the 
schedule and vice versa. 

1. On the View tab, click the Tile button to tile 
the schedule and other views onscreen. 

2. In the Mass Model_V1 file, make a change 
to the shape of the model.  

 

3. Reload the model into the project.  
4. When prompted, choose Overwrite the 

existing version. (Watch the area values in 
the schedule view as you do). 
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Exercise 10 – Energy Analysis 
Continue in the previous file. If you prefer, you can open 
the file named 10_Schematic Project_V3 instead. 

 
1. On the Analyze tab, on the Energy Analysis 

panel, click the Use Conceptual Mass Mode 
button.  

 

2. Click the Energy Settings button.  
3. In the “Energy Settings” dialog, for the 

Building Type, choose Hospital or 
Healthcare.  

4. Click in the Location field and in the dialog 
that appears, input the address of your 
project.  

5. Review the remaining settings. Accept the 
defaults and click OK.  

 

6. Click the Enable Energy Model button.  
7. Click OK to dismiss the warning dialog.  

 

8. Click the Run Energy Simulation button.  
9. If prompted, enter your Autodesk Sign in 

credentials and click Accept on the license 
agreement.  

10. In the “Run Energy Simulation” dialog, click 
the Continue button.  
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The model thus generated can be analyzed further in 
the viewport. Click to select various portions of the 
model and view their properties on the Properties 
palette.  

Additional Schedules can be created to list each Mass 
Zone and its properties.  

Click the Results & Compare button to see a report with 
comparisons to the various analysis run.  

 

 

11. Close all files.  
 

Using CAD Files in Families 
In this exercise you create a new Family based on an 
existing CAD file. New in Revit 2014, you can explode a 
CAD file containing 3D solids and they become 
converted to Free Form elements in the Family Editor. 

Exercise 11 – Using Solids in Families 
New feature for building content. 

 

1. From the Application menu, choose New > 
Family.  

2. In the “New Family – Select a Template File” 
dialog, choose Furniture and then click 
Open.  

3. Tile windows and zoom all to fit.  
4. On the Insert tab, click the Import CAD 

button.  

 

5. In the “Import CAD Formats” dialog, choose 
the RollingFile.dwg file.  

6. Set the Colors to Black and White and the 
Units to Inch. 

7. Set Positioning to Auto – Origin to Origin 
and then click Open.  

 

The file’s origin places it a little below the level. We can 
move it up.  

8. Select the imported CAD file and unpin it.  
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9. In one of the elevation views, select the 
CAD object and move it up 4". 

10. Click in the 3D view. Select the CAD object 
and then on the ribbon, click the Explode 
button.  

 

 

The exploded solids will become 3D Free Form 
elements. The exploded lines will become Model Lines.  

 

 

11. Save the Family As and give it a name.  
12. Load it into a project to test it.  

 

Exploded Free Form elements can have parameters 
applied to them to make them flex.  

Developing your Design 
In this exercise you refine your model by adding simple 
building elements like walls, doors, windows and stairs. 

 

Exercise 11 – Adding Walls 
This exercise shows basic Revit elements 

 

1. From the Application menu, choose Open > 
Project.  

• Browse to the file named: 
11_Arch_Model_Start.rvt. 

• Select it and click Open.  
2. Verify that the floor plan view named Basic 

Elements is open.  
3. On the Architecture tab, click the Wall tool.  

• On the Properties palette, from the 
Type Selector, choose I_MtlStud - 4 
7/8" Partition. 

• Near the bottom of the plan, draw a 
horizontal wall across the space from 
the centerline of the wall on the left to 
the centerline of the wall on the right.  

 

4. Repeat the process to create five vertical 
walls, making six rooms.  

 

5. Click the Modify tool or press ESC twice to 
complete the command.  

Exercise 12 – Using Dimensions 
Continue from the previous file. 
1. Select the new wall on the right.  
2. Click on one of the temporary dimensions 

and edit the value to 11.  
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This is a quick way to move elements precisely, but a 
permanent dimension is also effective and sometimes 
quicker.  

3. On the QAT, click the Aligned Dimension 
tool.  

 

4. Click the left edge of each wall to create a 
continuous string of dimensions across the 
plan. 

 

5. Continue clicking on the left edge of each 
wall until you reach the last wall you drew.  

6. Click in empty space (not on a wall) to 
finish.  

 

7. Above the dimension string, click the small 
equality toggle (the letters EQ with a slash 
through it).  

8. Click the Modify tool (or ESC twice).  
9. Select one of the walls in the middle.  
10. On the Options Bar, click the Activate 

Dimensions button.  

 

11. Locate the small boat anchor icon and drag 
it to the far right wall.  

 

12. Select the first wall to the right of the 
exterior wall.  

13. Edit the temporary dimension that appears 
to a value of 12.  

 

All of the other walls will shift with it to match the 12'-0" 
spacing.  

 

Exercise 13 – Adding Doors 
Continue from the previous file. 

 

1. On the Architecture tab, click the Door tool.  
• On the Properties palette, from the 

Type Selector, choose Single-Flush-w-
Metal-Frame: 36" x 84". 

• Highlight the long horizontal wall drawn 
above and click to place a door in one 
of the rooms.  
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2. Repeat in each room placing a door at 6" 
from the adjacent walls.  
• If necessary, use temporary dimensions 

to fine tune placement. 

 

3. Click the Modify tool (or press ESC twice).  
 

Revit will cut the holes in the walls automatically.  

4. Select the horizontal wall.  
5. Click the temporary dimension that appears 

and edit the value to 13.  
 

The adjacent walls will stay connected and the doors 
will move with the parent wall.  

Exercise 14 – Adding Rooms 
Continue from the previous file. 

 

1. On the Architecture tab, click the Room 
tool.  
• On the Options Bar, next to Room, click 

the drop-down (labeled New) and 
choose: 41 MECH.  

(Note: The room was previously added to the file via a 
Room Schedule – add new row).  

2. Click in the space at the far left to place the 
room and its tag.  

 

3. Change the Room to 42 DR OFFICE. 
4. Click in the next space to add the room.  
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5. Repeat for the remaining doctor’s offices.  

 

6. Click the Modify tool (or press ESC twice). 
 

Notice the square footage on the tags for all of the 
doctor’s offices is equal. This is because of the equality 
constraint applied to the dimension above.  

Exercise 15 – Changing Elements 
Continue from the previous file. Or if you prefer, open 
15_Arch_Model_V1.rvt.  

 

1. Select one of the walls separating the 
offices.  

2. On the Properties palette, from the Type 
Selector, choose: Interior - 6 1/8" Partition 
(2-hr).  

 

Notice the wall get a bit thicker and also the other walls 
adjust as well. This is again due to the constrained 
dimension. Notice the change in square footage in one 
of the offices.  

3. Select each of the office doors (make a 
window selection or click with the CTRL key).  

4. On the Properties palette, from the Type 
Selector, choose: Door Single s Side Light: 
36"x84". 

 

Note the change.  

5. Select the windows in one of the offices.  
6. On the Project Browser, double-click to 

open the North elevation view.  

 

Note how the windows are still selected.  

Sometimes the element type you want is not in the 
project. You can load families from outside files.  

 

7. On the Properties palette, click the Edit 
Type button.  

8. In the “Type Properties” dialog, click the 
Load button.  

9. Browse to Windows folder and choose 
another window such as: Archtop with Trim. 

10. Click Open, choose a size and then click OK.  

 

 

12 
 



AB3529-L  Autodesk® Revit® Architecture Workflow Fundamentals and New Features 

Exercise 16 – Using Dockable Windows 
Continue from the previous file. Or if you prefer, open 
16_Arch_Model_V2.rvt.  

 

New in this release, we can dock the Properties palette 
and Project Browser together into a single tabbed 
palette.  

1. Click and drag at the titlebar of the 
Properties palette.  

 

2. Drag it on top of the titlebar of the Project 
Browser and release. 

 

 

The two palettes will now combine with tabs at the 
bottom to switch between them.  

If you later decide to remove this, simply drag one 
palette away to “tear” it off (drag it away). Then drag 
back to your preferred location.  

Exercise 17 – Interconnecting Elements 
Continue from the previous file.  

 

1. On the Project Browser, double-click to 
open the ceiling plan named: Doctors 
Offices.  

2. On the Architecture tab, click the Ceiling 
tool.  

  

 

• On the Modify | Place Ceiling tab, click 
the Sketch Ceiling button.  

3. On the Draw panel, click the Pick Walls icon.  

 

 

• Click on the wall to the left between the 
MECH room and the office.  

• Click on the lower horizontal wall 
shared by all offices.  

• Click on one vertical and one horizontal 
exterior wall.  

You will have clicked a total of four walls.  

 

 

4. On the Modify panel, click the Trim/Extend 
to Corner icon.  
• Clean up each corner to form a closed 

rectangle. 
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5. On the Properties palette, from the Type 
Selector, choose: 2' x 2' ACT System.  

6. On the Modify | Create Ceiling Boundary 
tab, click the Finish Edit Mode (Green 
checkmark) button.  

This places a single ceiling across all of the offices. 
Let’s connect the walls to the underside of this ceiling.  

 

7. On the QAT, click the Section tool.  
• Click the first point inside the MECH 

room and the second point outside the 
rightmost office.  

 

 

• Open the new section.  
8. Select just the four walls separating the 

offices on the second floor.  
You can use a very thin crossing selection (drag right to 
left) across the very tops of the walls.  

(If you have trouble getting just the wall, click the Filter 
button on the ribbon and uncheck everything except 
walls).  

 

• On the ribbon, click the Attach 
Top/Base button.  

 

• Click on the ceiling.  

 

9. Select the ceiling. 
• On the Properties palette, change the 

Height Offset from Level to: 10'-0". 
10. Select the far left wall (the one between the 

office and the MECH room).  
• Move it about a foot to the left. (ignore 

any error).  

 

 

Notice how the connections to other elements are 
maintained in both the moving of the ceiling and the 
wall.  

Exercise 18 – Add a Stair 
Creating a new component-based Stair. 

 

1. Open the file named: 
18_Arch_Model_Stair_Start.rvt. 
• Open the floor plan view named: 

GROUND FLOOR.  
• Open the 3D view named: 3D Stair. 
• Tile the two windows and zoom in on 

the lobby area.  
2. On the Architecture tab, click the Stair by 

Component button.  
• On the Properties palette, verify that 

the type is: Assembled Stair: 7" max 
riser 11" tread. 

14 
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• For the Base Level, choose GROUND 
FLOOR 

• For the Top Level, choose SECOND 
FLOOR.  

3. In the plan view, click a point in the lobby to 
start.  
• On the Options Bar, for the Location 

Line, choose: Run: Left. 
Notice the cursor position relative to the stair run.  

• On the Options Bar, for the Location 
Line, choose: Exterior Support: Left. 

Again notice the cursor position relative to the stair run.  

 

 

• On the Options Bar, for the actual Run 
Width, input 4 and then press ENTER.  

4. Move the mouse to the right to create 
about 6 risers and then click.  

 

 

5. Click the next point above the end of the 
first run and keep it lined up.  
• Move to the left until all the remaining 

risers are used up and then click.  

 

 

11. Click on the small run. (Be sure to click the 
run and not the supports or landing).  
• Drag the small triangle grip at the end 

of the run slightly to the left. 
Watch the 3D view as you drag. Notice that the long run 
will shorten by the same amount of risers and that the 
landing height will also adjust. 

 

 

 

12. Click on the landing.  
• Drag the small triangle grip at the edge 

of the landing.  
• Drag it about the distance of one tread. 
• Repeat on the other side of the landing.  

15 
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Notice the runs will move with each adjustment to keep 
the stair components connected to one another.  

 

13. On the Properties palette, click the drop-
down at the top and choose Floor Plan: 
GROUND FLOOR. 

 

• Change the Underlay to SECOND 
FLOOR.  

 

 

 

This will display the outline of the floor slab above. You 
can use this to move the stair to the correct location in 
plan.  

14. Create a window selection around the 
entire stair (drag from left to right to 
surround it). 

15. On the Modify tab, click the Move tool and 
use object snaps to move the stair and snap 
it to the correct location relative to the floor 
above.  

 

 

If necessary, move again to fine-tune the placement 
and/or use the grips to adjust the runs as desired.  

 

16. On the Modify | Create Stair tab, click the 
Finish Edit Mode button (green checkmark).  

 

Exercise 19 – Add Railing Extensions 
Continue from the previous file or Open 
19_Arch_Model_Stair_V1.rvt 

 

1. Highlight the top rail of one of the railings.  
• Press TAB to highlight just the top rail 

and then click to select it.  
2. On the Properties palette, click the Edit 

Type button.  
• For the Extension (Beginning/Bottom), 

change the Length to 1 and then click 
Apply.  

 

The extension will apply to both railings since we are 
editing the Type.  

16 
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3. For the Extension Style, choose Floor and 
then click Apply.  

 

 

4. Try Post next.  
5. Click OK when finished.  

 

 

Exercise 20 – Modify a Railing 
Continue from the previous  

 

1. Delete the guard rail at the top of the stairs 
at the second floor.  

2. Select the stair railing on the outside edge 
of the stair.  
• On the Modify | Railings tab, click the 

Edit Path button.  
• On the Options panel, click the Preview 

checkbox.  

 

 

3. Starting at the end of the existing railing 
path sketch, add additional lines as shown.  

 

 

4. Click the Finish Edit Mode button.  
 

Notice that the railing is now continuous from the stair 
up to the guard rail.  

Exercise 21 – Select Lock Toggles 
Open 21_Arch_Model_Lock_Toggles_Start.rvt.  

 

1. Open the file named: 
21_Arch_Model_Lock_Toggles_Start.rvt. 
• Open the floor plan view named: 

GROUND FLOOR.  
2. On the Insert tab, click the Link Revit 

button. 

17 
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• For Positioning, choose: Auto – Origin 
to Origin.  

• Select the file named: 56750_S.rvt and 
then click Open. 

• In the warning, click OK.  
The structural model will appear onscreen.  

3. Move your mouse near the edge of the link. 
 

It will highlight.  

4. Click to select it. Try to move it.  
• Undo the move.  

5. On the Status Bar at the bottom right, click 
the first toggle icon.  
• Try to select and move the link again.  

 

 

Notice that it will no longer select or move.  

6. Zoom in at the lobby and notice the 
underlay linework (grayscale lines).  
• Try to select and move some of these.  
• Undo.  

7. Turn off the next toggle. 
• Try to select and move again. 

 

Notice that this time they will not select or move. 

Three other modes are included:  

• Pinned elements, prevents pinned 
elements from being selected.  

• Faces allows you select elements in 3D 
by clicking on the surface rather than 
the edges.  

• Press and Drag allows you to select and 
move in a single motion.  

Documenting your Design 
In this section we look at annotating you designs and 
creating documentation. 

Exercise 22 – Create a non-rectangular 
callout 

This exercise shows the process to set up a new view with 
annotation to document your project.  

 

1. From the Application menu, choose Open > 
Project.  
• Browse to the file named: 

22_Arch_Model_Doc_Start.rvt. 
• Select it and click Open.  

2. Verify that the floor plan view named 
GROUND FLOOR is open.  
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3. On the View tab, click the Callout drop-
down button and choose Sketch.  

 

 

4. Sketch lines down the middle of the 
corridor on the right side of the plan.  
• Draw the first segement down, then 

turn to the right then continue down 
again following the shape of the 
corridor.  

• Complete the in a rectangular shape 
surrounding the right portion of the 
building.   

 

5. On the Modify | Edit Profile tab, click the 
Finish Edit Mode button.  

 

Use the grips on the midpoint of each edge to fine-tune 
the shape of the callout if desired.  
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6. Select the callout, right-click and then 
choose Go to View.  

 

 

7. On the Project Browser, right-click the 
Callout of GROUND FLOOR view and choose 
Rename. 
• Type: Enlarged Lobby Floor Plan and 

then click OK.  
 

 

Exercise 23 – Add Room Tags 
Continue from the previous file or Open 
23_Arch_Model_Doc_V1.rvt 

 

1. Make sure that the Enlarged Lobby Floor 
Plan is open.  

2. On the Architecture tab, click the Tag Room 
button.  
• Click a point in the entrance foyer at the 

bottom of the plan.  

 

You can continue to click in other rooms to add their 
tags, or you can add them all at once using Tag All Not 
Tagged.  

3. On the Architecture tab, click the Tag Room 
drop-down button and choose Tag All Not 
Tagged.  
• At the top of the “Tag All Not Tagged” 

dialog, be sure that the “All objects in 
current view” radio button is selected.  

• From the list of tags, choose the Room 
Tag:Room Tag With Area item.  

• Click OK to place the tags.  
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On the left side of the plan, some of the rooms that fall 
outside the crop region received tags. We can remove 
these by either manually deleting them or adjusting the 
annotation crop region.  

 

 

4. Click to select the crop region.  
• Click and drag the control handle on the 

dashed rectangle surrounding the 
irregularly shaped crop region.  

• Drag it closer to the plan.  
 

Any tag intersected by this dashed annotation crop will 
disappear.  

Exercise 24 – Add Door Tags 
Continue from the previous file  

 

1. Repeat Tag All Not Tagged (You can find it 
on the Annotate tab as well).  
• At the top of the “Tag All Not Tagged” 

dialog, be sure that the “All objects in 
current view” radio button is selected.  

• From the list of tags, choose the Door 
Tag:Door Tag item.  

• Click OK to place the tags.  
2. Zoom and pan around the view to check the 

tags.  
3. Delete any tags you don’t need.  

 

 

Exercise 25 – Add Dimensions 
Continue from the previous file  

 

1. On the QAT, click the Aligned Dimension 
tool.  
• On the Options Bar, choose Faces of 

Core from the first drop-down.  

 

 

2. Click on the left vertical wall of PUBLIC 
RESTROOM 17.  
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• Click the next vertical wall on the other 
side of the room and continue with the 
two walls of the elevator.  

• Click a point above the rooms in the 
empty space of WAITING 35 to place 
the dimension. 

 

 

4. Repeat the process to add dimensions in 
other locations.  

5. Return to the dimension tool.  
• From the second drop-down, choose 

Entire Walls 

 

 

• Click the Options button.  
• Check Openings and choose Widths.  
• Click OK.  

 

 

6. Click on the exterior horizontal wall at the 
top of the plan.  

 

 

• Click above the wall to place the 
dimension.  

 

• Click the Modify tool or press ESC twice 
to finish.  

 

Exercise 26 – Make modifications 
Continue from the previous file or open the file named 
26_Arch_Model_Doc_V2.rvt 

 

1. Select one of dimensioned walls such as the 
one between the PUBLIC RESTROOM and 
the corridor. 
• Move the wall slightly.  

 

Note the change to both the dimension and the room 
tag.  
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2. Select and move one of the dimensioned 
windows on the exterior wall.  

 

 

3. On the Project Browser, open the floor plan 
view GROUND FLOOR. 

 

As you might expect, all changes to the model are 
reflected here as well, even though the annotation may 
vary.  
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Exercise 27a – Alternate Dimension Text 
Continue from the previous file  

 

1. Reopen the view named Enlarged Lobby 
Floor Plan. 

2. Select the dimension you added at the top. 
3. On the Properties palette, click the Edit 

Type button.  
• Click the Duplicate button and add the 

suffix: w MM to the name.  

 

 

4. Scroll down and for Alternate Units, choose 
Below. 
• Verify that Alternate Units Format is set 

to MM.  

 

 

You can modify the settings if you like.  

5. Click OK to see the results.  

 

 

Exercise 27 – Working with a Schedule 
Continue from the previous file  

 

6. Verify that the floor plan view named 
GROUND FLOOR is open. 

7. On the Project Browser, beneath the 
Schedules/Quantities branch, double-click 
to open the Room Schedule.  
• On the View tab, on the Windows 

panel, click the Tile button.  

 

 

You should now have the floor plan and schedule views 
side by side.  

 

8. In the schedule view, click to select the first 
room.  

 

Notice it highlight in the plan as well.  

 

9. Repeat by selecting a different room.  
10. Click and drag through several rooms.  

 

Notice them all highlight in the plan.  
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11. With the rooms still highlighted, click the 
titlebar of the floor plan view to switch 
focus to the plan.  
• On the Properties palette, change the 

Limit Offset to 10 and press ENTER.  
 

Note the change in both the Properties palette and 
schedule. Note in particular the Unbounded Height 
which is tied to the Limit Offset parameter.  

3. In the schedule view, click on the title.  
• Change the name to Room List and 

then press ENTER.  
4. Click in the Level header field and drag 

through all of the headers. (They will all 
highlight) 

 

• On the Modify Schedule/Quantities tab, 
click the Font button.  

• In the “Edit Font” dialog, change the 
Font size to 3/16". 

• Check the Bold checkbox and then click 
OK.  

 

 

5. Click again in the title field at the top.  
• Click the Font button again.  
• Change the font to Arial Black and the 

height to 1/4" and then click OK.  

 

 

6. On the Modify Schedule/Quantities tab, on 
the Titles & Headers panel, click the Insert 
Image button.  
• Browse to the image file named: 

patient_room_icon w Title.png and then 
click Open 

 

 

7. Click on the letter above the Unbounded 
Height column header (Letter E).  
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• On the Appearance panel, click the 
Align Horizontal drop-down button and 
choose Right.  

 

 

8. Repeat for the Limit Offset column.  
9. Click on Column F. 

• On the Columns panel, click the Delete 
button.  

 

 

Exercise 28 – Adding a Sheet 
Continue from the previous file  or open the file named 
28_Arch_Model_Doc_V3.rvt 

 

1. On the Project Browser, right-click the 
Sheets branch and choose New Sheet. 

 

 

• In the “New Sheet” dialog, accept the 
defaults and click OK.  

2. Right-click the new sheet and choose 
Rename.  
• Change the number to A103.  
• Change the name to Enlarged Plans and 

then click OK.  

 

 

3. On the Project Browser up under the Floor 
Plans branch, drag the Enlarged Lobby Floor 
Plan view and drop it on the sheet.  
• On the Options Bar, from the Rotation 

on Sheet drop-down, choose 90° 
Counterclockwise.  

 

 

4. Move the viewport to fit in the titleblock 
area.  

5. Select the viewport and on the Properties 
palette, click the Edit Type button.  
• At the top of the dialog, click Duplicate.  
• In the Name field type Viewport no 

Title and then click OK.  

 

6. For the Show Title parameter, change it to 
No and then click OK.  

26 
 



AB3529-L  Autodesk® Revit® Architecture Workflow Fundamentals and New Features 

Visualizing your Design 
In this section we look at visualization tools and 
techniques you can use to present your designs.  

 

Exercise 29 – Using Displace Elements 
This exercise shows the process to create an “exploded” 
3D view of a portion of your design.  

 

1. From the Application menu, choose Open > 
Project.  
• Browse to the file named: 

29_Arch_Model_Vis_Start.rvt. 
• Select it and click Open.  

2. Verify that the 3D view named Displace is 
open.  

 

 

 

3. Select the top shading device element.  
• On the Modify | Generic Models tab, on 

the View panel, click the Displace 
Elements button.  

 

 

A small colored displacement icon will appear on the 
selected element. Red moves along the X, green moves 
along the Y and blue moves along the Z. 

 

 

4. Highlight the green arrow and drag it away 
from the face of the building.  
• With the element still selected, drag up 

slightly with the blue arrow.  
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5. Repeat the steps with the other two 
shading devices.  
• Move the middle one in the Y direction 

only away from the face of the building 
• Move the lower one away from the face 

of the building and down slightly.  

 

 

6. To fine-tune placement, click the Right face 
of the ViewCube.  

 

 

• Click on each shading device and use 
the green and blue arrows to fine-tune 
the positions.  

 

 

• To return to the previous axonometric 
view, highlight the ViewCube and then 
click the Home icon that appears.  

 

 

Displace one more element.  

 

7. Select the Curtain Wall. (Be sure to click the 
curtain wall itself – dashed outline – not the 
mullions or glass).  
• Displace this element and move it 

slightly away from the exterior wall with 
the green arrow.  

• Make any further adjustments to the 
positions of any of the four displaced 
elements.  

8. Select one of the displaced elements.  
• On the Modify | Displacement Set tab, 

on the Displacement Set panel, click the 
Path button.  

 

 

• Click near the ends of the shading 
device to add a few paths. 
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• Continue clicking at the edges of the 
other displaced elements.  

• Click the Modify tool or press ESC twice 
to finish.  

 

 

9. Select the Section Box surrounding the 
view.  

10. On the Modify | Section Boxes tab, on the 
View panel, click the light bulb icon and 
choose Hide Elements. 

 

 

 

Try orbiting the view. Notice that the displaced elements 
and lines orbit with the rest of the model.  

 

11. Open another 3D view. 
 

Notice that the elements are not displaced elsewhere.  

 

Try duplicating the view.  

• Duplicate will not copy the 
displacement.  

• Duplicate with Detailing will also 
duplicate the displaced elements.  
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Exercise 30 – Accessing Materials 
Continue from the previous file  or open the file named 
30_Arch_Model_Vis_V1.rvt 

 

1. On the View Control Bar, click the Visual 
Style pop-up and choose Realistic.  

 

 

Realistic mode displays the materials live in the shaded 
viewport. If you want to edit the materials, use the 
Material Browser. 

 

2. On the Manage tab, on the Settings panel, 
click the Materials button.  

 

 

Materials in the current project are listed on the left. Edit 
the currently selected material on the right in one of 
several tabs.  

 

3. Scroll down and select the material named: 
Render 255-0-0.  

Notice the red color assigned to the Shading value. This 
material is assigned to the blades of the shading device, 
however this color is not being used to render it.  

 

 

4. Click OK to dismiss the dialog.  
• Change the Visual Style to Shaded.  

 

Notice that the shading devices now use the red color. 
When rendering however, Revit will use the same 
settings shown in the Realistic visual style.  

 

5. Change back to Realistic Visual Style. 
• Reopen the Materials dialog and select 

the material named: Render 255-0-0 
again. 

• Right-click it and choose Rename.  
• For the name type: Shading Louver 

Blades. 

 

 

• Click the Appearance tab.  
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Here you can see that the color is dark gray instead. 
Appearance settings are used for rendering and 
Realistic shading.  

 

• Click on the color swatch. 
• In the “Color” window that appears, 

choose a color that you like.  
6. Click back on the Graphics tab.  

• Check the “Use Render Appearance” 
checkbox.  

 

 

• Click OK to see the result.  
7. Zoom in on the louvers 

• Try both shaded and Realistic Visual 
Styles.  

Notice that the color will now display in both modes.  

 

 

 

Another way you can access the materials on an 
element is to select it and edit its properties. The 
shading device is part of a displacement set, so to edit 
it, we need to use the TAB key.  

 

8. Highlight the shading device, press the TAB 
key. Verify that the Status Bar shows that 
the Generic Model is highlighted and then 
click.  

 

 

• On the Properties palette, click the Edit 
Type button.  

• Click the small browse button in the 
field next to Support Material.  

 

 

9. In the “Material Browser” click the Show 
Library Panel icon at the top. 

 

 

• At the bottom of the dialog, on the left 
side, scroll down and select the Metal 
category.  

• In the right panel, scroll down and 
locate a metal material you wish to use 
like Steel, Polished.  

• Place your mouse over the material and 
when the small arrow appears, click it.  
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This adds the material to the current document.  

If an error appears, click Replace.  

10. Click OK to assign the material.  
• Click OK twice more to dismiss the 

“Material Editor” and “Type Properties 
dialogs. 

 

Exercise 31 – Create a Cloud Rendering 
Continue from the previous file  or open the file named 
31_Arch_Model_Vis_V2.rvt 

 

1. On the Project Browser, verify that the 
Displace 3D view is open.  

First prepare your settings for Rendering. 

2. On the View Control Bar, click the Visual 
Style pop-up and choose Graphic Display 
Options.  

 

 

3. In the “Graphic Display Options” dialog, 
configure the following settings: 
• Under Model Display, choose Realistic 

for Style.  

• Under Shadows, check the Cast 
Shadows box.  

• Under Lighting , for the Scheme, choose 
Exterior: Sun only.  

• Under Background, choose Gradient 
and accept the default colors.  

• Click OK to dismiss the dialog and apply 
the changes.  
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4. On the View tab, on the Graphics panel, 
click the Render in Cloud button. 
• If prompted, log into your Autodesk 

account.  
5. In the “Render in Cloud” dialog, click 

Continue. 

 

 

6. In the second “Render in Cloud” dialog, 
configure the following: 
• For the 3D View, choose: Displace.  
• For the Output Type, choose: Still 

Image. 
• For the Render Quality, select your 

desired quality. (Higher quality takes 
longer). 

• Choose an Image size. (Larger image 
size takes longer).  

• Choose an Exposure setting and 
preferred File Format.  

7. Click Start Rendering.  

 

 

If you check the box, Cloud Rendering will email you 
when the rendering is complete.  

 

8. On the View tab, on the Graphics panel, 
click the Render Gallery button.  
• Login to your 360 account.  
• View and/or download your rendering.  
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Further Study 
You can find more information and tutorials in  
The Aubin Academy Master Series: Revit Architecture.  

If you want a deep dive into the Family Editor try my new book:  
Renaissance Revit: Creating Classical Architecture with Modern Software.  
Past Autodesk University Class: 

“Autodesk® Revit® Families: A Step-by-Step Introduction” visit: www.pauluaubin.com/au to learn more.  

 

I also have Revit video training available at: lynda.com/AU2013/PaulFAubin. I have 
several Revit courses at lynda.com: Revit Essentials (2011 and 2013), Revit Family 

Editor, Revit Architecture Rendering and Advanced Modeling in Revit 
Architecture, Phasing and Design Options, Up and Running and more on 

the way soon.   

The Revit Family Editor course is devoted entirely to the Family Editor and content creation. The 
Advanced Modeling course covers the Massing Environment as well as many other related topics.  

If you have any questions about this session or Revit in general, you can use the contact form at 
www.paulaubin.com to send me an email.  

Follow me on twitter: @paulfaubin 

 

All of your lab monitors from today also have resources available and teach classes here at Autodesk University. Do 
a search for: 

Brian Mackey, Founder, BD Mackey Consulting, Desiree Mackey, Professional Engineer, BIM Manager: 
Martin/Martin, Steve Stafford, CEO, AEC Advantage.com  

 

http://paulaubin.com/books/
http://paulaubin.com/books/
http://www.pauluaubin.com/au
http://lynda.com/AU2013/PaulFAubin
http://www.paulaubin.com/

